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While AutoFill is one of the most common and easy-to-use Excel feature, there are plenty of things to check when it stops working. You might be dealing with incorrect Excel settings, or maybe you’re doing something wrong without realizing it. Either way, the solutions below should help fix AutoFill in no time. 1. Enable the Fill Handle Sometimes,
Excel’s AutoFill feature might stop working without any warning. When this happens, your first step should be to check if the AutoFill option is enabled. Open the File menu and head to Options. There, select Advanced from the left-hand menu and scroll down to the Editing Options section. Check the Enable fill handle and cell drag-and-drop option.
Additionally, you should check Alert before overwriting cells to avoid accidentally editing important information. Sometimes, AutoFill doesn’t work as intended if you don’t provide enough data for the tool to detect an algorithm. Try to select more cells before using AutoFill or manually enter more data before dragging the AutoFill handle. The AutoFill
feature might stop working if there’s a conflict with another Excel tool. For example, if you've added a filter to sort Excel data, AutoFill can’t detect an algorithm that it should use. Columns or rows with applied filters usually have the Filter icon in the topmost cell. To remove the filter, go through the below steps: Select the row or column containing
the filter. Open the Data tab. From the Filter menu, click Clear. The AutoFill feature works differently if you press and hold Ctrl or Command while using it. If you press and hold the key while trying to fill the cells, AutoFill will repeat the data instead of extending the series of numbers, text, or dates. Now, if you're not actively pressing Ctrl or
Command, there’s a chance the key got somehow stuck. In this case, there are a few options that you could try: Clean your keyboard to remove any debris that might interfere with the key’s functionality. Disconnect the keyboard if you're using a USB or Bluetooth keyboard. Remap the keys, so the Ctrl or Command key doesn’t have a functional role
anymore. Another setting that might stop the AutoFill feature from working is the calculation option. In Excel, open the Formulas tab and open the Calculation Options menu. There, select Automatic. If you can’t click and drag to autofill your cells, you should use a different method. Select the cells with the data you want to use and open the Home
tab. From the Editing menu, select Fill > Series. If AutoFill is still not working, and you can’t find anything wrong with Excel settings, there’s a chance that Microsoft 365 has some damaged or missing files. In this case, you should repair Microsoft 365. Here’s how you can do it on a Windows computer: Press the Windows key + I to launch the
Settings menu. Go to Apps > Installed apps. Click the three-dot icon next to Microsoft 365. Select Modify. In the popup window, choose Quick Repair. Click on Next. If this doesn't get AutoFill working again, go through the above steps again, but this time, select Online Repair. Windows will run a more detailed troubleshooting process. Hopefully,
Excel AutoFill is working again, so you don’t have to copy and paste the formula for each cell. If you’re using a pirated version of Microsoft 365, there’s a chance you can’t fix AutoFill no matter what you try. However, you can get Microsoft 365 for free and enjoy its full functionality. Quick Tips Ensure that Excel is configured to calculate cells
automatically and remove any unnecessary filters. If Autofill is not working only in a specific workbook, copy the data to a new Excel file. Consider running the Office repair tool if nothing else works. Try a different workbook: Testing the AutoFill feature in a different workbook will help determine if the issue is limited to a specific Excel file. In that
case, consider copying the data to a new workbook. Check cell data and format: AutoFill may not work in Excel if your data does not have a consistent and recognizable pattern. For example, if you have a list of dates, ensure they are all in the same format. To use the AutoFill feature in Excel, ensure the fill handle is enabled. If not, you will not see the
small plus sign when you move your cursor towards the bottom right corner of a cell. Step 1: Open Microsoft Excel and click the File menu at the top left corner. Step 2: Select Options from the left pane. Step 3: Switch to the Advanced tab and tick the boxes for Enable fill handle and cell drag-and-drop and Alert before overwriting cells. Then, click
OK. AutoFill in Excel can also help you apply the same formula to a series of cells. However, your formulas might not calculate the result if the automatic calculation option is not active in Excel. Open Excel on your PC > click the Formulas tab > Calculation Options > select Automatic from the resulting menu. Once you do that, the AutoFill feature
should work as expected. Applying filters in your Excel sheet can also prevent the AutoFill feature from working. This is because Excel only considers the visible cells when filling in data, leading to unexpected results. Try removing unwanted filters in Excel and see if that fixes the issue. Open your Excel sheet and switch to the Data tab. In the Sort &
Filter section, click on Clear. After that, see if the AutoFill feature works. Although clicking and dragging cells is the most typical method of utilizing the AutoFill feature, it’s not the only one. You can try the Fill command in the Home tab to see if that works. Open your Excel sheet > select the cell with the data and the adjacent cells you want to fill.
Under the Home tab, click the Fill option in the Editing section > choose the type of fill you want to use. Microsoft includes a handy repair tool for fixing various issues with Office apps. You can try running this tool to see if it makes the AutoFill feature work in Microsoft Excel. Step 1: Press the Windows key + R to open the Run dialog box. Type
appwiz.cpl in the box and press Enter. Step 2: In the Programs and Features window, locate and select the Office suite or Microsoft 365 on the list. Then, click on Change at the top. Step 3: Select Online Repair and click Repair. Last updated on 05 June, 2024 The article above may contain affiliate links which help support Guiding Tech. The content
remains unbiased and authentic and will never affect our editorial integrity. In Microsoft Excel, the Autocomplete feature helps users quickly automate the same text in multiple rows. In some cases, the Autocomplete feature will not work. In this article, we will explain what you can do if Excel Autocomplete is not working.The Autocomplete feature
will show suggestions based on other entries that are already included in the column, and you will choose what you want to insert into the cell. The Autocomplete feature also suggests formulas for example, if you type = S, Excel will suggest the SUM and SUMIF functions.If Excel Autocomplete is not working, you have to check that Autocomplete is
not disabled and that there are no Blank cells in the dataset.Check if Autocomplete is disabledIn this tutorial, you will notice that we have ice cream at the table, but when we try to type ice cream below, the Autocomplete is not working. Once you type ice, it should show cream at the end.To enable the Autocomplete feature, follow the steps
below:Click the File tab on the ribbon.On the backstage view, click Options on the left.An Excel Options dialog box will appear.Click the Advanced tab on the left pane on the dialog box.Under Editing Options, check the checkbox for ‘Enable Autocomplete for all cell values;’ this will enable Autocomplete.Then click OK.Now check if the Autocomplete
feature is working by trying to type ice cream.Check if there are any Blank cells in datasetSometimes, the issue can occur due to blank cells in the table. Follow the steps below.Right-click on the blank cell row and click Delete.The row containing the blank cell is deleted; now, check if Autocomplete is working.There is another method where you can
fix this issue when it comes to blank cells. Insert data into the blank cell adjacent to the column where you want to enter the text.Now, try to type the text into the cell of that column to see if the Autocomplete feature is working.Why did my AutoComplete stop working in Excel?If you notice that the AutoComplete feature is not working, there are two
reasons why it is not working. AutoComplete will not work due to it being disabled. AutoComplete also will not work if there are blank cells in the dataset.READ: Freeze Pane not working in ExcelWhat is the difference between Autofill and Autocomplete in Excel?Autofill and autocomplete are both important and useful features in Excel, but they have
their differences. Autofill is a feature in Excel that allows users to automatically enter data if the user is entering a predictable series; for instance, days of the week, month, or numbers, Excel will display the rest of the sequence in the table. The Autofill feature should not be mistaken for the Autocomplete or the Autocorrect feature; they are
completely different and have different functions. The Autocomplete feature automatically finishes text while you're typing, especially text that is already available in your dataset.READ: Unable to insert Columns in Excel. Autocomplete in Excel is a feature that can greatly enhance productivity and efficiency. It allows users to quickly fill in data by
predicting what they wish to type based on previous entries. However, it can be frustrating when this helpful feature suddenly stops working. This article explores the common reasons why autocomplete may not function as expected in Excel, as well as a detailed guide on how to fix these issues. Understanding Autocomplete in Excel Before diving
into troubleshooting methods, let’s clarify what autocomplete is in Excel. Autocomplete is a function that enables Excel to predict the text you are typing based on what you have previously entered in the same column. For instance, if you have previously typed "Apple" in a cell, when you begin typing "A," Excel will suggest "Apple" as a completion.
Benefits of Autocomplete Time-Saving: Autocomplete speeds up data entry by reducing the need to fully type common phrases or values. Consistency: It helps maintain uniformity in entries, particularly for large datasets, ensuring that spelling and formatting remain consistent. Ease of Use: The feature is intuitive, aiding those unfamiliar with Excel’s
other functionalities. Reasons Autocomplete May Not Work If you're experiencing issues with the autocomplete feature in Excel, several factors may be at play. Here are some of the most common reasons: 1. Autocomplete Functionality is Disabled This is often the simplest fix. Sometimes, users inadvertently deactivate the autocomplete function
without even realizing it. Excel allows users to toggle this functionality on or off. 2. Data Entry in a Non-Column Format Autocomplete works best in columns of data. If your entries are scattered across a row or if you are trying to use it in a non-standard format, this could cause issues. 3. Mixed Data Types Autocomplete may struggle to predict
entries correctly if there is a mix of data types in the same column, such as texts, numbers, or dates. The predictions can become unreliable and may stop functioning entirely. 4. Sheet Protection If the sheet is protected, certain functionalities—including autocomplete—may be disabled to prevent unauthorized changes. 5. Corrupted Files Sometimes,
the Excel workbook or the application itself could become corrupted. This corruption can cause various features, including autocomplete, to malfunction. 6. Conditional Formatting Conflicts Conditional formatting could potentially interfere with autocomplete. If cells are formatted in a way that Excel interprets as unique, predictions may not appear.
7. Excel Settings Various Excel settings could influence the way data entry features work. It’s essential to check general options, especially during a fresh installation or an update. Troubleshooting Autocomplete Issues Step 1: Check Autocomplete is Enabled Open Excel and go to the File tab. Click on Options at the bottom. In the Excel Options dialog
box, choose the Advanced category from the left pane. Scroll down to the Editing options section. Ensure the Enable AutoComplete for cell values checkbox is checked. Click OK to apply your changes. Step 2: Ensure Data is in Column Format Review the layout of your data. Confirm that the entries you wish to use autocomplete on are located in a
continuous column. If they are in a row, consider transposing your data. Step 3: Check for Mixed Data Types Analyze your column for inconsistencies in data types (numerical values mixed with text entries). If this is the case, standardize your entries. For example, if you are working with text data, convert all numbers or dates to text format. Step 4:
Remove Sheet Protection Go to the Review tab. Check if the Unprotect Sheet option is available. If it is and you have the password, click it to unprotect the sheet. This should enable the autocomplete feature. Step 5: Repair the Excel File Close Excel. Open Excel again and choose Open from the File tab. Select the file that is causing issues without
opening it. On the Open button, click the downward arrow and select Open and Repair. Follow the prompts to repair the file. Step 6: Adjust Conditional Formatting Check if you have applied conditional formatting to the column. You can do this by selecting the cells and reviewing the applied rules under the Home tab -> Conditional Formatting ->
Manage Rules. Adjust or remove rules that might affect data entry. Step 7: Adjust Excel Settings In the Excel Options menu, navigate back to the Advanced section. Scroll down to ensure settings like Format and calculation options are correctly configured. Restart Excel after making any changes. Additional Solutions If none of the above methods
have solved the issue, consider these alternatives: Update Excel Excel often releases updates that fix bugs and improve functionality: Go to the File tab and select Account. Under Product Information, click on Update Options and choose Update Now. Follow on-screen prompts to install any pending updates. Reinstall Excel If you suspect that your
installation of Microsoft Excel is corrupted, consider reinstalling it: Go to the Control Panel from your PC settings. Select Programs and Features. Locate Microsoft Office in the list, right-click, and select Uninstall. Reinstall Office from the Microsoft website or your installation media. Use Excel Online As a temporary workaround while
troubleshooting, consider using Excel Online. Go to Office.com and log in to access a browser-based version of Excel, which doesn’t rely on the local installation and may not have the same issues. Seek Technical Support If all else fails, you may want to contact Microsoft Support for dedicated assistance. They can guide you through troubleshooting
steps specific to your installation and configuration. Conclusion Autocomplete is a powerful feature in Excel that can simplify data entry and increase productivity. However, when it ceases to work, it can lead to frustration. Fortunately, the causes behind this issue are often simple and manageable. By following the troubleshooting steps outlined in
this article, most users should be able to restore the autocomplete functionality in their Excel applications. Stay diligent in keeping your Excel installation up to date, periodically reviewing your settings, and ensuring data entries are organized correctly. By doing so, you can help ensure that this valuable feature continues to serve you effectively,
facilitating smoother workflows and more efficient data management. Whether you are analyzing data for business or personal projects, Excel’s autocomplete feature can be a game-changer when it’s working optimally. Microsoft Excel is a powerful tool for managing data, but its effectiveness is often amplified by its features. One such feature is
Autocomplete, which simplifies repetitive tasks by suggesting and completing text based on existing entries. However, there are instances when Autocomplete seems to take an unexpected break. In this article, we’ll delve into the common issue of Excel Autocomplete not working as it should and explore the solutions to get it back on track.
Understanding Excel’s AutoComplete Before we dive into problem-solving, let’s grasp the essence of Excel’s Autocomplete. This feature is designed to streamline data entry. It operates by analyzing the content in the column you’re working on and offering suggestions based on the entries it finds. As you start typing, Excel presents you with a list of
potential completions derived from your previous inputs. This not only accelerates data input but also minimizes errors. Moreover, Autocomplete isn’t just about text. It’s a smart tool that extends its assistance to formulas as well. For instance, if you begin typing “=S,” Excel might promptly suggest relevant functions like SUM and SUMIF, making
your formula creation a breeze. Understanding the Issue Before we dive into the solution, let’s ensure we’re on the same page about the problem. Imagine you’re working in Excel, and you start typing “ice,” expecting to see “cream” suggested by Autocomplete. But nothing happens. It’s as if Autocomplete has gone on vacation. So, what could be
causing this? There are a couple of common culprits. First, it’s possible that Autocomplete is disabled in your Excel settings. Second, your dataset might have pesky blank cells disrupting Autocomplete’s smooth operation. Troubleshooting Excel Autocomplete When Autocomplete decides to go on a hiatus, it can be frustrating, especially if you're
accustomed to its time-saving capabilities. Here are some steps to troubleshoot and resolve the issue: Solution 1: Check Autocomplete Settings Let’s begin by confirming that Autocomplete is enabled in your Excel settings. Here’s a step-by-step guide: Step 1: Click the File tab on the ribbon at the top of your Excel window. Step 2: On the backstage
view that appears, click Options on the left-hand side. This opens up the Excel Options dialog box. Step 3: Within the Excel Options dialog box, click the Advanced tab on the left pane. Step 4: Now, under the ‘Editing Options’ section, keep an eye out for a checkbox that reads ‘Enable Autocomplete for all cell values.” Make sure this box is checked.
This action activates Autocomplete. Step 5: To finalize your changes, simply click OK. Now that we’ve rekindled Autocomplete’s flame, it’s time to put it to the test. Try typing “ice” once more and see if “cream” magically appears at the end as it should. Solution 2: The Blank Cell Conundrum Blank cells can be innocent-looking troublemakers when it
comes to Autocomplete. They lurk in your dataset, wreaking havoc by interrupting the smooth flow of suggestions. Here’s how you can tackle them: Method 1: Deleting Blank Rows Step 1: Begin by right-clicking on the row containing the troublesome blank cell. Step 2: From the context menu that appears, select Delete. With a swift click, the
problematic row vanishes into the digital abyss. Now, go ahead and test Autocomplete once more. Method 2: Filling in the Blanks Alternatively, if you’d rather not part with your data, you can fill in those pesky blank cells. Here’s how: Step 1: Insert the desired data into the blank cell situated next to the column where you intend to use Autocomplete.
Step 2: Now, attempt to type your text into the cell of that column. Does Autocomplete spring back to life? By either eliminating or populating those blank cells, you're removing the stumbling blocks that were preventing Autocomplete from doing its job. In this second step of troubleshooting Excel Autocomplete, we’ve addressed the issue of blank
cells in your dataset. With these solutions at your fingertips, you're one step closer to reclaiming the efficiency and convenience of Excel’s Autocomplete feature. Stay tuned as we explore more potential fixes in the following sections. Solution 3: Data Consistency / Data Validation Autocomplete depends on the existing data within the column. If you're
facing issues, it’s wise to confirm that the data is correctly formatted and doesn’t contain any hidden characters, extra spaces, or trailing spaces in your data that might be disrupting Autocomplete. Solution 4: Restart Excel Sometimes, a simple software restart can resolve Autocomplete issues. Save your work, close Excel, and then reopen your
spreadsheet to see if the feature is functioning correctly. Solution 5: Check for Software Updates Outdated software can sometimes lead to compatibility issues. Ensure that you’'re using the latest version of Excel by checking for updates and installing any available patches. Solution 6: Try the Autofill Handle When working with a large dataset, you
might not see Autocomplete suggestions immediately. In such cases, use the autofill handle (a small square at the bottom-right corner of a selected cell) to drag and populate adjacent cells with the desired content. Solution 7: Add to Autocomplete List If Excel isn’t providing suggestions for a specific set of entries, you can manually add them to the
Autocomplete list. Go to “File” > “Options” > “Advanced,” and click on the “Edit Custom Lists” button. Here, you can input your custom entries. Conclusion Excel’s Autocomplete feature is a time-saving tool that enhances productivity when working with large datasets. However, if you find that Autocomplete is not working correctly, follow the
troubleshooting steps mentioned above to get it back on track. By checking settings, validating data, and ensuring you have the latest updates, you can resolve Autocomplete issues and make your Excel experience smoother and more efficient. Frequently Asked Questions (FAQs) Question: What are the possible reasons why AutoComplete is not
working in Excel? Answer: There are several possible reasons why your AutoComplete feature stopped working in Excel. Here are some common causes and solutions: You have disabled the AutoComplete option in the Excel settings. To enable it, go to File > Options > Advanced. Under Editing options, make sure the checkbox for “Enable
AutoComplete for cell values” is checked. You have blank cells in your data set. Excel will not AutoComplete values if there are empty cells in the column. To fix this, you can either fill in the blank cells with some values or sort your data to remove the blank cells. You have formatted your cells as a specific data type, such as number or date. Excel will
not AutoComplete values that do not match the data type of the cells. To fix this, you can either change the format of your cells to text or general, or enter values that match the data type of the cells. You have turned off automatic calculation in Excel. This can affect the AutoComplete feature as well as other functions. To turn on automatic
calculation, go to the Formula tab and click on Calculation options. Select Automatic. You have a software glitch or a hardware issue that prevents Excel from working properly. To fix this, you can try restarting Excel or your computer. You can also check for updates on your Excel software and install them if available. If none of these steps work, you
can try searching for more solutions online or contacting Microsoft support for assistance. Question: How do Autofill and Autocomplete in Excel differ? Answer: Autofill and Autocomplete are two features in Excel that can help you enter data faster and easier. However, they have some differences in how they work and what they can do. Here are
some of the main differences between Autofill and Autocomplete in Excel: Autofill is a feature that automatically fills a range of cells with data based on a pattern or a series. For example, if you enter 1 and 2 in two adjacent cells, and drag the fill handle (the small square at the bottom right corner of the selected cell) down or across, Excel will fill the
rest of the cells with 3, 4, 5, and so on. Autofill can also fill dates, days of the week, months, formulas, and custom lists that you create. Autocomplete is a feature that automatically completes a cell value while you are typing, based on the values that already exist in the same column. For example, if you have a list of names in column A, and you start
typing a name that matches one of the existing names, Excel will show a drop-down list of suggestions that you can choose from. You can also press Enter or Tab to accept the suggested value. Autofill can fill a large range of cells with data in one action, while Autocomplete can only fill one cell at a time. Autofill can also create new values based on a
pattern or a series, while Autocomplete can only use existing values in the same column. Autofill can be activated by dragging the fill handle, double-clicking the fill handle, or using the Fill option in the Home tab. Autocomplete can be activated by typing a value that matches an existing value in the same column. Autofill can be customized by
creating your own lists of values that you want to fill. You can also change the default settings for Autofill by going to File > Options > Advanced > Editing options. Autocomplete cannot be customized by creating your own lists of values. You can only turn it on or off by going to File > Options > Advanced > Editing options. In Excel, you will find that
sometimes the autocomplete of cell values will not work. And in this article, we will dig out the reason. In Excel, sometimes you need to enter duplicate contents into a column repeatedly. In such a case, AutoComplete feature in Excel will save your time. Whenever you input the first character of an existing string, Excel will complete the remaining for
you automatically. A Case when AutoComplete Works In this image, you can see that we have already input the phrase “DataNumen Excel Repair” into cell A1l. And now we will input the phrase “DataNumen Access Repair” into cell A2. Both phrases start with the same character “D” or “d”. So when we enter the character “D” or “d” into the cell, the
existing phrase will automatically appear. And this is the feature of autocomplete. If you use Excel frequently in your work, you may have already found this feature. Why AutoComplete Fails to Work? However, sometimes you may find that even if you input the first character of an existing string, the string will not pop up. And we have find out the
reason. Now we have input the phrases “DataNumen Excel Repair” into A1 and “DataNumen Access Repair” into cell A2. Now in Cell A3, we need to input the same phrase “DataNumen Excel Repair”. But when we type the character “D”, that string will not appear. Even if we input the “DataNumen” or “DataNumen ”(with the space), it still doesn’t
appear. Till now, many may think the AutoComplete feature stops working, or Excel just expects you to input a different string smartly so it does not perform auto complete any more. But that is not the case. Actually, there are two different phrases with the same beginning “DataNumen ” (with the space) in Cell A1 and A2. So if you only type part of
or the whole “DataNumen ” (with the space) into A3, Excel doesn’t know if you want to input the same value as Al or A2. Therefore, the autocomplete will not show up. Only when the count of inputted characters is large enough to match ONLY one of the existing strings, the autocomplete will appear. So in the above case, if we continue inputting the
character “E” into the cell, there is ONLY one existing string that matches your input, i.e., “DataNumen Excel Repair”, so AutoComplete will pop up that string again. On the other hand, we can also solve the uncertainty by telling Excel which string we want directly. Just do as follows: Input first several characters of the string. Press the shortcut keys
“Alt+ | ” In the drop down list, all existing string with the same characters at the beginning will appear. Select the string you want instead of inputting all its characters manually. Besides, you can also right click the cell and choose “Pick from Drop-Down list” to invoke the drop-down list as well. Disable the Autocomplete Feature Sometimes you don’t
need the feature of autocomplete, you can also disable it. In the image below, you can see that we input “DataNumen Excel Repair” into Al. And in A2, we want to input another phrase “DataNumen Access Repair”. The autocomplete value will also appear as usual. And if you press the button “Enter” habitually, you need to come back to the cell and
modify again. This will cause inconvenience to you. Thus, you can turn off this feature manually. Click “File” in the ribbon. And then click “Options”. Next you will see the window of “Excel Options”. Here click “Advanced”. In the “Edit options” part, uncheck the option “Enable AutoComplete for cell values”. Last click “OK”. Now you have finished all
the settings. And if you enter the similar values into the cell, the autocomplete will not appear in cell. In addition, even if the feature is disabled, you can still press “Alt+ | ” to open the drop-down list in case you need to input the same contents. Recovery Tool is a Must for Excel Users If you use Excel frequently, you will certain meet with Excel
corruption at some point. Thus, you are recommended to prepare a third party tool to repair Excel. Once such accident happens, you can use this tool immediately. And your data and information can be well preserved in Excel. Author Introduction: Anna Ma is a data recovery expert in DataNumen, Inc., which is the world leader in data recovery
technologies, including word recovery and outlook repair software products. For more information visit www.datanumen.com In Column B, the Fill Handle was used to make a series of numbers starting from ‘1’. But repetitions of 1 were returned. To get a series of numbers (1,2,3...), use the Fill Series option manually. Select Fill Series from the menu
and the series of numbers will be displayed. Solution 2 - The Series Autofill is Not Working While Dragging the Last Cell Only ‘1’ and ‘3’ are entered in B4 and B5. You want to create a series of numbers with a common difference of 2: 1,3,5,7,9... Dragging down the Fill Handle from B5 returns repetitions. Select the column first. Here, B4 and B5. Use
the Fill Handle in B5 and drag it down to B10. The correct series of numbers is displayed. Solution 3 - The Excel Autofill is Not Working in Distant Columns in the Same Worksheet Column B has a series of numbers starting from 1. Column D has two numbers only, 1 and 3 in D4 and D5. If you double-click the Fill Handle in D5, it won't fil the series
due to the gap between Column B and Column D and the presence of blank cells in Column C. Transfer the data in Column D to Column C. Double-click the Fill Handle to see the series of numbers. Read More: Drag Number Increase Not Working in Excel Solution 4 - The Fill Handle Option Is Not Enabled in Excel To enable the Fill Handle option
manually: In Excel Options, go to the Advanced tab. In Editing Options bar, check ‘Enable fill handle and cell drag-and-drop’ and ‘Enable AutoComplete for cell values’. Click OK. Solution 5 - The Autofill is Not Functioning Properly with a Filtered Table To remove the Filter, press CTRL+SHIFT+L. Solution 6. The Automatic Calculation Is Turned Off
In the following dataset, C4 contains a value (calculated by multiplying the value in B4 with 5). The Fill Handle will show repeated values, because the Automatic Calculation is turned off. Go to Formulas. In Calculation Options, choose ‘Automatic’. This is the output. Read More: [Fix] Auto Fill Options Not Showing Solution 7. The Autofill with Flash
Fill is Not Working Properly The dataset contains text values in Column B under the Text header. To extract the country names, use the Flash Fill option. Extract the country name manually from the first cell only and enter it in C5. Use the Fill Handle to autofill the column and select the Flash Fill option. Flash Fill option found a pattern and extracted
the values between two hyphens. Data must be arranged in a specific pattern as shown below in Column B. Download Practice Workbook Download the Excel workbook. Use of Autofill with Fixed Issues.xlsx AutoFill Not Working: Knowledge Hub



